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Advanced Digital Video
by
John Fox

Workshop Description

Learn how to use some of the introductory, intermediate, and
advanced techniques of digital video (DV) and “imovie” computer
software. We will only go as fast and as far into DV production as
the class is comfortable with. No prior knowledge of digital
video equipment or imovie is required.

Presentation Style

This is an activity based workshop where the participants will
actually plan, record with a DV camera, transfer to a computer,
and edit a DV movie using imovie. Very brief, but adequate,
demonstrations and assistance will be provided by the presenter.
Advanced features and special effects will be covered at the end
of the work shop.

Activities you will be doing
Work in a small group to produce a digital video production
using imovie as follows:
1. See a short demonstration on how to plan, record, transfer,
and edit a movie using imovie.
2. Plan your three minute movie by making a short story board.
3. Tape your video on the DV camera.
4. Transfer (Capture) the video from the DV camera to the
computer.
. Edit the video by cropping parts of it.
. Add some pictures to your video from the internet.
. Add transitions between the clips and screens
. Add music and sound effects to your video.
. Add a title page and credits to your video.
. Save and play you completed movie.
If time allows, you will learn some advanced features such as
exporting the video to a CD, or the web, bring a standard
VHS video into imovie, add more special effects to the movie.
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Workshop Instructions and Procedure

Overview of the Activity
You will be working in groups of two to four people to make a
three minute movie of a simple process. Your group will work
with the same movie in each of the following steps. The activity
will be divided into four separate parts:

1. Introductory movie

2. Basic movie

3. Full featured movie

4. Advance special effects. (To be covered if we have time.)

Step One: Introductory Movie
I will demonstrate the entire process by actually doing a sample
video as follows:
1. Choose one of the sample processes to make a demonstration
video.
2. Complete the story board sheet outlining the video.
3. Set up and briefly rehearse the video.
4. Record your demonstration with the DV camera.
5. Transfer /capture the video to the computer using imovie.
6. Play the video and crop unwanted parts.
7. Add a title at the beginning.
8. Save your video and play it.

Step Two: Basic Movie
You will continue working on the same movie you started with,
only this time you will add some basic features to it as follows:
1. With your imovie project open add the “cross devolve”
transition between each clip.
2. Add four audio sounds to your movie.
3. Add music at end of your video.
4. Save your video and play it.
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(Workshop Instructions and Procedure Continued)

Step Three: Full Featured Movie
You will continue working on the same movie you started with,
only this time you will make it a full featured movie to it as
follows:
1. With your imovie project open import two to four pictures off
the internet to the end your movie.
2. Change the length of the pictures to 00:08:00.
3. Add the transitions of your choice between each of the
pictures you got off the net.
4. Add credits at the end of your movie.
5. Add music at end of your movie.
6. Save your video and play it.

Step Four: Advanced Special Effects (15 minutes to complete)
If time allows you may add special effects to your movie as
follows:
1. With your imovie project open, try applying one of the
“Effects” to a clip.
2. Add a title/text over one of the pictures.
3. Add more sounds and music, downloaded from the net to
your video.
4. Export your movie to a CD or to the web.
5. Experiment with any special effect you desire to spice up your
movie.

Conclusion

Hopefully you learned some useful things about DV production
today. Please look over the hand outs, check out some of the
resources on the web, keep using imovie, and you will master it in
no time. Please give me a call if you need any help, want to come
in and use the computers, or would like me, or a “techie”, to come
to your room for assistance.






Pre-Production Storyboard

Directions: Use this outline to describe each video clip that you will be using
with simple sketches and a brief description.
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IMovie in a Nutshell
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. Connect camera to Imac.

. Turn on camera and start iMowvie.

. Choose New Project from the File menu.

. Give your movie a name and then click on Create.

. If you don't see, “camera is ready,” check to see if camera is on, or

click camera icon.

. Locate video clips to the shelf (clipboard). Spacebar starts or stops

capture.

. Edit scenes (split at head) or apple T.

. Delete unwanted footage apple x, or delete key. (remember

to empty trash)

10. Drag the “keepers” to the time line or clip viewer (edit again if

necessary).

11. Add transitions, music, sounds, titles, ect.

12. View finished product using time line viewer or clip viewer. (edit

again if necessary).

13. Export back to DV camera (file.. export movie or apple e).

14. Dub to analog (VHS) tape for mass viewing.
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[-Movie for digital video production:

. Get permission from Mr. Fox to use the digital camcorder.
" Check over the digital camcorder to be sure it has a good battery and a tape in it.
_ Plan out what you want to tape, and write-up an outline or, story board, if necessary.
. Tape the video production being sure to keep the camera steady, stop and start the .
camera between clips, and avoid excessively zooming in and out.
5. Once you’ve completed taping your video please request Mr. Fox's permission to
hookup the fire wire cable from the computer to the digital carmncorder so you can import
your video to the hard drive of the computer.
6 Now that the digital camcorder is hooked up to the fire wire launch “I-movie II" by
going under the open apple, recent applications, [-movie.
7 With [-movie now open you first go to “file” “new project” and name it, then select
 sate”. Remember, just about any question can be answered by using the I-movie help
index or the ttorial.
8. Now “import” your video by first clicking on the camera /dv icon then select import.
Please remember to save your changes often.
9 Your video will then be viewed as it plays through on the screen as the clips are being
displayed on the “shelf” for future editing.
10. Once your video is imported press stop and select the clips from the shelf and place
thern in the sequence you want them to appear on the large long horizontal box at the
bottom ot the screen called the “play head”™.
11. You’ve just completed the first level of digital video editing. You can now go back
and play your video by using the “play” button. After viewing your video in [-movie
you may want to edit it further. Follow the directions in class, or use the [-movie “help”
menu bar, to “move”, “delete”, “crop”, or “import” clips from other [-movie files.
12. Now you can add “titles”, “transitions’”. “effects” and “audio” as demonstrated in
class to complete your video. Please remember to save your changes often.
13 After all your editing has completed the “rendering” process, and you have saved
your changes, you may want §o back and take a last look at you video and make any
further changes as described above.

. The final step is to “export” your completed video back to the digital camcorder. and
later to VHS tape, as demonstrated in class.
15 You have now successfully completed digital video editing with I-movie II.
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RULES FOR VIDEO TAPING

-Know your cam corder: read the manual and work with
the cam corder.

-Plan: follow the story board, set-up scenes, props, ect..
-Keep a scene and tape footage log.

-Run through each scene before actually taping.

-Retape each scene in question.

-Keep the camera steady: use image stabilization or tripod.
-Move in close and fill the frame/view finder.

-Keep things in focus and use manual focus if necessary.
-Keep a simple, solid, no glare background when possible.
-Have a 3 second lead-in and lead out on every sceen.
-Speak load, slow, clear, and close to the camera.

-View the video on a TV immediately after taping and redo
poor sceens.

-Mark and lock the tape in a safe place and bring it with
you to school the next school day.

GOOD LUCK!

scene and tape footage log
SCENE NAME START END







Desktop Movie
Resources

_ http:/ /www.apple.com/education/dv/
Desktop Movies are a powerful way to capture students’ enthusiasm for learning, energize
teaching, and expand the education community.

http:/ /www.apple.com/education/dv/gallery /index.html
Examples of Desktop Movies used in the classroom.

http:// www.sprmgfield.klzﬂ.us /movie/

Education Examples from Springfield, IL

http:/ /ndwild.psych.und.nodak.edu/grabe/imovie/movies.html
Education Examples from North Dakota

http:/ /www.apple.com/education/dv /tips/index.html
Tips for making your movie

http:/ /www.apple.com/imovie/
Learn more about iMovie. Find tutorial information here.

http:/ /www.atomiclearning.com
The atomic Learning Library - online training - FREE video tutorial series for iMovie 2.

http://dvcreators.net/
Training and resources for Digital Video (iMovie & Final Cut Pro)

http:/ /www.apple.com/imovie/freestuff/
Free Stuff - A Library of backgrounds, sound effects, and looping music.

http:/ /www.pics4learning.com/
Copyright free images for education

http: / /www.GeeThree.com
More special effects for iMovie!
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http:// www.freeplavmusic.com/

http:/ /www.freshmusic.com/ /7 (/___7‘4{(’//{{/(7 5
(o.d
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http:/ /www.musicbakery.com/

http:/ /www.rovaltyfreemusic.com/



http:/ /pblmm.k12.ca.us/TechHelp /VideoHelp /VideoGuide.html
Video Guide for Project-Based Learning with Multimedia
http:/ /pblmm.k12.ca.us/PBLGuide/Activities/BeginningProduction.html

http: / /www.2-pop.com/
2-pop -The Digital Filmmakers Resource

http: / /ali.apple.com/
Apple Learning Interchange

http:/ /ali.apple.com/ali/resguide display.php?guidenum=705
Classrooom Video: All Levels - Resource Guide

http:/ /www.ideas.wisconsin.edu/linkspage.html
IDEAs - Resources with alignment to Wisconsin Sate Academic Standards.

http:/ /www.apple.com/education/k12/imagine/
Imagine - K-12 Success Stories

http:/ /www.apple.com/education /itools/
iTools for Education

http:/ /www.apple.com/iphoto
iPhoto software and information

http:/ /www.apple.com/itunes/
iTunes software and information

http:/ /www.apple.com/finalcutpro/
Final Cut Pro

http:/ /www.apple.com/quicktime/

QuickTime

http: / /www.apple.com/quicktime /products/galler
Cubic VRs

http: / /www.apple.com/appleworks

AppleWorks - ideas and examples

http://www.apple.com/education/k12/products/appleworks/
AppleWorks for Education

Janis Schwab

Apple EDE
schwab@apple.com Apple Computer, Inc.
homepage.mac.com/schwab www.apple.com

www.apple.com/education
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The revolutionary digital video
application that helped Mac users
create a million mini-documentaries
seen by their friends and relatives
around the world now brings several
dazzling new features to your screen.

One of the things you'll appreciate about the

connects to the rest of the ilLife applications
to let you do even more with your digital
video. That means you can, for instance,
bring in and send out digital media content
directly from application to application,
import audio from iTunes and images from
iPhoto, and create chapter markers in your
movie that automalically turn into scene
selection menus in iDVD.

New visual effecis

. : You'll love the iMovie 3 visual effects like
Lens Flare, Aged Film, Letterbox, Thermograph and Electrical Arts. Want to
sprinkle a glittering trail of fairy dust over a festive scene? iMovie 3 lets
you do that, and even lets you decide at which point in the frame you want
to use it. iMovie also lets you add haunting visual effects like fog and
ghost trails to your movies in seconds. What's more, you can bring your
digital stills to life with professional documentary-style impact, using
the Ken Burns pan and zoom effects you've seen in PBS specials.

Sophisticated audio controls

http:/fwww apple com/imovic/

lalest version of iMovie is how seamlessly it

iLife - $49.00
Available January 25lh
from the Apple Slare.

zvailehle as part ol
1 iPhoto 2. iDVD 3

wilh &

iowniload

""Sfe‘é‘ iMovie 3 in action

CnsickTine mo
vig in action,

Edit Clips
Add Pholos
Import Music

Add Transiticns

Apply Effects

Playback

Page 1 of 3
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audio controls in iMovie 3. For starters, you can have
three audio tracks, counting your production sound
(that is, the track that gets automatically recorded
when you capture digital video footage on your
camcorder). iMovie 3 offers flexible volume level ) < e
customization on all three audio tracks. You can, for example, mute
unwanted production sound, pump up the volume on peorly recorded audio
tracks, and adjust the volume of entire tracks up or down.

. Convenient chapter markers

The fact that you can now add chapter
markers to your movies is a benefil that
extends beyond iMovie; it lets iDVD create
scene selection menus so your viewers can
. jump directly to their favorite scenes.

" What's more, adding chapter markers is as
simple as placing the playhead wherever you want them and then clicking
Add Chapler. That enables you to give your new chapter a title or a number
for easy reference, and makes it easy for your friends and family to skip
around and find their favorite scenes within iMovie.

Send your iMovie to DVDs — instantly

The moment you save your movie, it's ready for iDVD — no more export
processes. Once you put in your chapter markers, click on the Create DVD
project button, and you'll be immedialely laken to iDVD. No need to export
your digital video footage to QuickTime first. iMovie 3 takes you directly
lo the iDVD environment.

Stunning Skywalker Sound Effects

iMovie 3 comes with an exclusive collection of
Skywalker Sound Effects from seven-lime Academy
Award winner Gary Rydstrom, sound designer and
Director of Creative Operalions at Skywalker Sound. Now
you can score and mix your movies with sound effects
created by the same sound wizards who revolutionized
the audio industry, and created the incredible sound effects for just about
every blockbuster movie in the last two decades — including Star Wars,
Jurassic Park, Toy Slory, A Bug's Life, Saving Private Ryan and Titanic,
just to name a few.

Make your own movies

For the benefit of those of you
who've never used this most
appealing of applications
(especially the legions of
Windows users who are reading
this), iMovie is a digital.video
editing application that's so easy
to use, you don’t need a manual to
get started making your own
movies. And if you're wondering
what you'll make movies about,
the answer is just about anything
you've captured with your DV R .
camcorder and digital camera. You can even use iMovie 3 with digital
photos, pulling in all your favorites from iPholo and creating your own
doecumentary.

hitp:/fwww. apple com/umovie/

1/8/03 8.26 PM

iLife: iMovie 3

Explore your iLife:

= Let {Tunes provide lhe
soundlracks for your movies

= Use your iPholo Library in
wilh the “Ken Burns” effect

r Create DVD Chapter markers
for use in iDVD

New in iMovie 3:

+ New liquid limeline editing
interface

# New audio effects from
Skywalker Sound

= Ken Burns documentary-
style effects

= Complete control of clips,
music and sound effect
volumes

- Pro-guality special effecls
and new titles

+ Chapter markers for use
with your DVD projects

= Send movies to iDVD with
one click

= Shared media browser lels
you access all music and
pholo files from one place

" Visual Plugins
i Gee Three
= Vitrix
i CSB Digital
i eZedia

Audio Effects

 Skywalker Sound
= Audiodish

w Hollywood Edge

E_iiMovie Feedback
" Help us make iMovie i }

even betler. We'd love ¢
o hear from you.

Riis =

More about itlovie

= Camcoder _compatibilily
w Camera compatibility

Page 2 of 3
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video foolage wilth cne click, and
automatically separates the scenes
for you. And that's when the fun
starls. iMovie lels you pick oul the
good parts, snip oul the slow or boring
parts, shuffle scenes around to your
heart's content, and add sound. There
are three ways 1o add sound to your
movie: use one of the included sound
effects, add a musical track from a CD or your own iTunes music library, or
record your own voiceover. When you're done editing, you can add lext as
end credits, rolling commentary or opening litles. You can choose from
several slyles, and decide on a lext color and typeface. By then il will be
time for sharing your movie — and for getting started on your next one.
iMovie 3 has you covered there as well, with integration with iDVD. Soon
your masterpieces will be beautifully displayed in your family’s DVD shelf
right along with the Hollywood blockbusters.

Home > Scliware > ilLile > iMovie

S Seanal”

Site Map | Search Tips

Visit the Apple Store online or at relail locations.
1-800-MY-APPLE

Contact Us | Privacy Policy
Copyright © 2003 Apple Computer, Inc. All rights reserved.

hutp:/iwwiw.apple.com/imovie/ Pape 3 of 3



Producing and Editing a Digital Video Production

Please complete all of the following steps in doing a digital video production.

1. Establish a group of between three to five students and meet to determine the following
positions/assignments:

_ -Director (person in charge)

-Secretary (note taker)

-Other group members

B—

2. Discuss the following and yecord you results below:

A. Format of the video: (music video, commercial, interviews, ect...)

B. Topic of the video

C. Sample/example to format the video after.
D. Approximate Length of the video. minutes

F. Props and costumes you will need for the video.

G. Where will you be taping this video?

3. Once you've completed the above discuss your results with Mr. Fox and then complete the
story board on the following pages.

1. After completing the story board sheet discuss it with Mr. Fox and make any necessary
changes.

5. Do a dress rehearsal of you video in front of your class mates and make changes
accordingly.

6. Do the final taping with the digital camera being sure to follow the taping fundamentals as
demonstrated in class. Please remember to speak loudly, slowly, and clearly and avoid any
rapid camera movements of excessive zooming in and out.

7. Follow the “Step for using imovie” to digitally edit your video using the G-4 computer.

8. Show the finished video to Mr. Fox for grading then export it to the digital video tape and
then make copies on the VHS tapes.
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Whzt You Can Do

iMovie is an easy-to-use digital video editing software application. With iMovie and a digital
video camcorder, you can create and edit your own movies. Import video from the camera;
edit clips; and add transitions, tidles, sound effects, and music. Then copy the movie to a
camcorder tape or create 2 QuickTime movie. You can even share your QuickTime movies by
placing them on the web on your Apple iDisk or HomePage,

Your computer comes with iMovie for Mac OS X and Mac OS 9.

To Get Started
Shoot your video, then connect the camera to your computer's FireWire port.
Open iMovie in the iMovie folder (located in the Applications folder).

Click the Import button to import movie clips to the shelf, then add them to your movie by
dragging them to the clip viewer.

Assemble and edit your movie in the clip viewer and timeline viewer
Add transitions, titles, sound, and music.

When you are finished, choose Export from the File menu.

Tips and Tricks
Share your desktop iMovie with your friends and family

Export your movie as 2 QuickTime web movie and copy the movie to your iDisk. Then
use HomePage to create your own iMovie theater so that others can view your movie on
the Internet,

To Learn More

For more information on using iMovie, see the iMovie Tutorial or iMovie Help. For the
latest on iMovie, including iMovie updates, additional plug-ins, and a list of compatible
DV camcorders, go to the iMovie website at www.apple.com/imovie

Getung Started With Your Computer 35




Imovie Instructions 176/03 1.02 PM

This is lhe html version of the file hitp.//www2 milwaukee k12 wi.us/pt3/filepdfimac class 3 (WP) pdf.
G o .- g ! e automatically generates html versions of documents as we crawl the web.

| To link to or bockmark this page, use the following url: ntep: //wwn. google. com/search? g=cache suzhRl_BDZREC: www2.m luaukee. k12 .wi.us/pt3/filepdt/
Imac_class_3_(WP).pdf+imovie+instructionsghl=entie=UTF-8

Google ws not affiltated with the authors of tlis page nor responsible for 1ts content.

These search terms have been highlighted: imovie
These terms only appear in links pointing to this page: instructions

Page 1
Imovie Steps

Fred Turk
email lurkfa @ mail. milwaukee.k12.wi.us

The first step in creating your movie is getting the foctage from your camcorder into your
Mac. IMovie is designed for use with camcorders that use MiniDV tapes and use a firewire
interface. If you don't have a DV camcorder with fireWire, you can buy an analog to DV cenverter
(Sony $400) to get the footage into the computer. Connect your iMac DV and your DV camcorder
using a FireWire cable. IMovie controls your camcorder. The playback controls look and work just
like a VCR or CD player control. IMovie controls work only with compatible DV camcorders
(see a current list at www.apple.com/imovie/gear/ Once the camcorder is connected, start the
iMovie program, then just choose New Project from the File menu, give your movie a name, and
click on Create. Once you are in the Camera Mcde, you will see a blue screen and a message
saying the camera is connected.

Separate Scenes

When you import (capture) video, iMovie places an icon on a "shelf" (clipboard); a series of
frames on the right hand side of the screen, and names it clip 01. You can capture an entire 60-
minute DV cassette as a single clip (if you have enough free disk space). You can import specific
scenes by using iMavie's scene-detection feature, which causes iMovie to begin a new clip each
time it detects a scene break. To turn on a scene detection, choose Preferences from the Edit
menu, click on the Import tab, and check the box labeled "Automatically Start New Clip At Scene
Break”. You can also start and stop clip capture by pressing the spacebar as a videotape plays
back. This is a handy way to grab portions of scenes: click on iMovies's Play button to play the
tape, and when you see something you want to capture, press the spacebar to grab it. From here
you can add the clip to your project by dragging it from the shelf onto the timeline viewer (the strip
below the playback controls).

iMovie's shelf is a grid of thumbnail images. The number of clips it holds depends on the
iMac DV's screen resolution. The shelf holds 9 clips at the iMac DV's default resolution. To expand
its capacity to 12 clips, use the finders control strip or the monitors control panel to boost the screen
resolution to 1,024 by 726. Whatever you do, don't change the resolution to 640 by 480, doing
so causes iMovie to quit. Each minute of digital video uses about 210MB of disk space, so unless
you really have hard-disk space to spare, don't capture anything that you know won't make it into
your final project. | bought an external 30gig firewire harddrive ($179) to help get past this
limitation.

Assembling After Capturing

Once you've captured the raw video clips into iMovie, they are placed on the shelf
(clipboard) From the shelf you can drag the clips from the shelf to the Clip Viewer. Once in the clip
viewer you can sequence clips, add transiticns, titles, music and more.

Iittp #216.239.37 |00/scarch?g=cache wzhRI_BD2REC www? milwaukee k12 wius/pt3/flepd Floac_class_3_(WP) pd{timovictmstruclipns&hl=endic=UTF-8 Page 1 of 3
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Name Your Clips
iMovie automatically names captured clips, but names like Clip 01 and Clip 02 aren't
exactly descriptive. You can rename clips simply by clicking on their names. Give them
descriptive titles to help you identify them

Page one

Page 2
Cropping You're Clips

More than likely each of the clips you capture have stuff you don't want. Cropping or cutting
will remove this extra footage, make a better movie, and reclaim disk space. To crop a clip in
iMovie, you position crop markers to indicate the material you want to keep. Or you can go to edit,
down to split at video head (apple T). This creates two video clips where there once was one.
Press apple X or delete to eliminate the unwanted scene. You may use the arrow keys to better
help position the split. When you crop a clip, iMovie puts its discarded portion in the Trash (not the
same Trash as the Finder's trash can), but a separate, iMovie-specific Trash. You can reclaim disk
space by emptying iMovie's Trash as you work. (Choose Empty Trash from the iMovie File
menu). Emptying the Trash can, may take a few minutes, but the disk space saved is worth the
wait.

Playing One Item At a Time

You can choose to play just one item- a clip, a title, a transition, or a music soundtrack-by
selecting that item in the Clip Viewer and then clicking on the Play button or hitting the spacebar.
This is a way to check out a title or transition you've just added. To play an entire project, click small
monitor, (see screen shot) or deselect everything (press apple key D), click in a blank area of the
Clip Viewer, and then click on Play. If you need to move a clip a significant distance, (a clip from the
end of a project to the beginning), you can drag it and let the clip window scroli automatically.
There's a faster way. Drag the clip from the Clip Viewer into any empty box on the shelf, scroll
through the Clip Viewer to the new destination, and then drag the clip from the shelf back into the
viewer.

Transitions and Titles

Titles can help describe a place or a scene, or they give credit where credit is due. Visual
transitions can be easier on the eyes than large jumps between scenes. Transitions can even help
tell a story. A cross-dissolve (one clip fading out while another fades in) can imply the passage of
time, To superimpaose title text over a specific clip, select the clip before opening the titles
palette. Be sure to choose a text color that adequately contrasts with the clip's contents. It is good
to use chunky fonts that are easier to read despite the TV's limited resolution( Arial Black works
well). Inserting a clip between two clips connected by a transition is a two-step process. First,
delete the transition by click on it,press delete. Now insert a new clip.

Updating Titles and Transitions

If you change your mind about using a particular font, title, or transition, first click en it in the
Clip Viewer, make the changes, and then click on the Update button in the Titles or Transitions
palette in the Effects palette. When you create a title or transition, iMovie must create its video
frame. This rendering process takes time and memory; you'll notice that iMovie slows down when

hitp /216 239 37.100/scarch?q=cache uzhR1_BD2REC www aulwavkee k12 wi us/p3/filepdf/imac_class 3 (WP) pdf+imovietinstructions&hi=cadic=UTF-§ Page 2of 3
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it's taking place. To gauge how long the wait will be, look at the window that contains the transitions
or titles you've added. A little red progress bar shows how far along rendering is progressing.
Cross-dissolve is one of the most often used transitions, perfect for creating a graceful transition
between scenes and for implying the passage of time. You can add more than one transition at a
time, {limited to amount of ram available), by dragging the transitions between clips. You can also
change the length of the transition by sliding the arrow towards the left in the preview window
before you add the transition between clips. The numbers below the preview window indicate the
length of the transition. You can alter the length by sliding the arrow. Remember your selected clip
has to be long enough for the transiticn to take place.

Page Two

Page 3
Adding Music

iMovie's audio features are weak. You can't, for example, replace one clip's audio track with
another's. If you have a clip with unintelligible noise in the background, consider adding a music
soundtrack. To do this, click on the clip, then lower the scene’s audio levels until they're quieter than
the music but still audible. If you do not want to hear the clip's audio, mute it. When you add a
transition before a clip, select the transition and then turn its volume down pariway or all the way. If
you split a clip at the point where you want to change its sound leve! (choose Split Clip At
Playhead (apple T, from the Edit menu). You now have two clips with levels you can adjust
independently.

Exporting Your Movie

You've finished the movie, now it's time to export it. Go to file, then (export movie, or
press apple e). With iMovie's Export Movie command you can record it to videotape, or save it
as a QuickTime movie. When exporting to videotape, iMovie lets you add a few seconds of black
before the movie begins. Unfortunately, it doesn't let you add black after the movie. To add some
black, try to record a little bit with the lens cap on. This will create blank (black) footage. You then
can move the clip to the end of your movie. If you need more black footage you can copy and
duplicate clips with iMovie.

More Advanced ldeas
Adding Still Images
You can also import still images into a project and combine them into a videc slide show, or
add them in different places in your movie. iMovie lacks image-tweaking features, so you can't
crop, or otherwise tweak your images. Do your image-editing befere you import your images.
IMovie displays still images for a default time of 10 seconds. You can change the amount of time
an image appears on the screen, by selecting the image and then typing a duration value in the
time area of the Clip Viewer. After you've imported images, add transitions between them (cross-
dissolves work well). You can import a power point presentation by saving it as a JEPG, then
from iMovie going to edit, import files, naviagate to the saved power point jepg files and highlight
them, click import.

Importing Quicktime Movies
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iMovie can't import QuickTime movies but if you have Apple's $29 QuickTimePro
.apple.com/quicktime/upgrade/), there is a work around. Open the movie with QuickTime

player, select the Export command, and choose the Movie To DV Stream option from the Export

pop-u

p menu.
Importing Older Analog Video
Video you shot with your old camcorder can also be edited. Simply dub your analog

cassettes to your DV camcorder by connecting the analog VCR's outputs to the DV camcorder's
inputs with standard video patch cords. Once you've made the connections, press your DV
camcorder's record button and your VCR's play button. When you've finished, use iMove to
capture the DV dub.

Page lhree

Page 4

Closing Thoughts

* | would grab the iMovie Plug-in Pack from the apple site (www.apple.com/imovie/).

It adds six title styles and eight transitions effects to your imovie package.

¥ The last page is a screen shot of iMovie. | tried to label parts that | thaught would be
useful,
IMovie in a Nutshell

1. Connect camera o Imac DV computer
2. Turn on camera and start iMovie
3. Choose New Project from the File menu.
4. Give your movie a name and then click on Create.
5. If you don't see, "camera is ready," check to see if camera is on, or click camera icon.
6. Locate video clips using player controls.
7. Download video clips to the shelf (clipboard). Spacebar starts or stops capture
8. Edit scenes (split at head) or apple T
9. Delete unwanted footage apple x, or delete key(remember to empty trash)
10. Drag the "keepers" to the time line or clip viewer (edit again if necessary).

L T N L
AW NN =

. Add transitions, music, sounds, titles etc.

. View finished product using time line viewer or clip viewer(edit again if necessary).
. Export back to DV camera (file..export movie or apple e).

. Dub to analog (VHS) tape for mass viewing.

Page 4 of 3



Create Movies with Windows Movie Maker

l ;

| Wmdows XP

Prod uct In fo rmatlon

:.How to Buy
Usmg Wmdows XP

mDownloads
Support

-Expert Zone Commumty i
e |
T

-Wlodows Farmly
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Wmdows Update
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Get thelatest

Find easy ways to express your creatiwty and
share home movies with new features in
Windows Movie Maker 2. Then, extend your
fun with the new Microsoft Plus! Digital Media
Editicn.
Windows Movie Maker 2 Download
AutoMovie: Quick, Easy Home Movies
Mew: Microsoft Plus! Digital Media Edition

Do Amazinglhings

)

Create Home Movies Effortlassly
From camera to computer to finished
product, you'll be amazed how quickly
your home maovies come together
with Windows Movie Maker 2.

Make Movies Like a Pro

With transitions and effects like you
see in movies and on TV every day,
Windows Movie Mzker 2 gives your
home movies an impressive
professional quality.

Share Movies dnywhers
Windows Movie Maker 2 makes it
easy to show off your movies. You
can send them in e-mail, post them
to Web sites, copy them to a CD, or

even copy to DVD!

See It m Action

httpi/Awww microsoft.com/windowsxp/moviemaker/default asp

Support |

1/8/03 6:56 PM

Search |

microsoft.com Guide

Windows Movie Maker 2 makes home movies amazingly fun and easy, letting you create, edit,
and share your home movies right on your computer with a few simple drag-and-drop moves.
Add special effects, music, and narration. Then share your movie via the Web, e-mail, or CD.
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Vndeos & Demos

:Top 10 List
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- How to: Get Started
Learn Mcre
Be an Expert

- How to:
.How to:

DVGear

FREE digital video training
tape with every DVGear
workstation.

More special offers
See the complete list.

Download Windows Mavie
Maker 2

Make movies like the pros.
Add cool effects, transitions,
and more. Watch cool

sample _movies made with
Wmdows Movie Maker 2.

Free Winter Fun Pack
Downloads

Get the Digital Video with
Windows Movie Maker 2
Winter Fun Pack and get cool
sounds, music, and titles and
transitions.
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Movie Malker Videos

See videos of people like you doing
amazing stuff with Movie Maker—then
learn how to do it yourself,

Talke It tothe NextLevel

Exiend Your Experience with Piusl
Digital Media Edition

Plus! Digital Media Edition delivers
exciting new ways to enjoy your
photos, music, and home movies with
Windows XP.

Addd Effects o Titles

From freeze frame video to
claymation, Windows Movie Maker 2
is loaded with tools and features that
give full reign to your creative

POWETS.

Create Vides Transitions

Wipes, dissolves, and much more:
Check out all the great new
transitions that come with Windows
Movie Maker 2.

More Amazinglhings

With the features in Windows XP you
can enjoy your favorite music and
movies whenever you like, exchange
instant messages with friends and
family, work with digital photos, and
more, Start here.

5 Top
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Meptune Mediashare Video
Contest

Simply make a short movie
using Windows Movie Maker,
submit it to Neptune’s Video

Pixelan SpiceFX Packs

To enhance your editing
power and creativity, see
Pixelan's cutting-edge
organic effects and
transitions that you can add
to Windows Movie Maker 2,

Check Out Windows XP
Media Center Edition

Enjoy all the features of
Windows XP, plus watch and
record TV, manage music,
play DVDs, and more.

Windows Catalog
Find products built to work

with Windows XP.
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Started
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A feature of the Home and Professional
Editions of the Windows XP operating
system, Windows Movie Maker 2 for
Windows XP includes all of the tools and
features you'll need to create entertaining
movies that have a professional look and
feel. To use Movie Maker, you must have
Windows XP installed on your computer.
Please note that when you acquire Windows
XP, it comes with an older version of Movie
Maker—to take full advantage of all of the
power and fumetfiomality that Movie Maker
now offers, you may want to download
Movie Maker 2.

Windows Movie Maker 2 requires the
following minimum system configuration for
your PC:

x Microsoft Windows XP Home
Edition or Windows XP
Professional

= A 600 megahertz (MHz)
processor, such as an Intel
Pentium I1I, Advanced Micro
Devices (AMD) Athlon, or
equivalent processor

= 128 megabytes (MB) of RAM

Downlead Windows

Movie Maker 2

Make movies like the
pros. Check out.the
cool effects, transitions,
and more in Windows
Movie Maker 2.

Edition

For exciting new
transitions and effects,
check out Microsoft
FPlus!, which adds new
eye-popping visual
effects and transitions
from Pixelan Software.
If you enjoy these
amazing effects, you
can check out other
Pixelan nroducts for
Windows Movie Maker

= 2 gigabytes (GB) of free hard disk space
= An audio capture device (to capture audio from external

sources)

hitp /fwww micrasoft.com/windowsxp/moviemaker/getstarted/nighthardware.asp

A DV or analog video capture device (to capture video from
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external sources)

= An Internet connection (to save and send a movie to the
Web or to send a movie as an attachment in an e-mail
message)

Keep in mind that video editing is a processor-intensive activity. In order to
optimize your experience and the performance of Windows Movie Maker,
we recommend the following;

= A 1.5 gigahertz (GHz) processor, such as an Intel Pentium
4, an AMD Athlon XP 1500+, or equivalent processor

= 256 megabytes (MB) of RAM

You will need capture hardware to transfer videos into your PC. The
hardware required will depend on the source of your video.

If'you have a digital video (DV) camera, you’ll need either a FireWire card
(also known as IEEE 1394) or an analog video capture card. FireWire is
recommended for the best quality results. Many new PCs come with a
FireWire card already installed. If not, there are a number of manufacturers
that make a card that will work with your PC.

If you have an analog camcorder, a Web camera, or a VCR, you will need an
analog video capture card.

To play the movies you’ve created with Movie Maker, you will need the
following software:

= Microsoft Windows Media Player 7.0 or later (Windows
Media Player 9 Series is recommended to optimize movie
playback)

= Microsoft Windows 98 or Iater or Windows NT® 4.0 or
later

& Top
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Find easy ways to express your creativity and
share home movies with new features in
Windows Movie Maker 2. Then, extend your
fun with the new Microsoft Plus! Digital Media
Edition,
Windows Movie Maker 2 Download
AutoMovie: Quick, Easy Home Movies
New: Microscft Plus! Digital Media Edition

Do Amazingl'hings

Create Home Movies Effortlessly
From camera to computer to finished
product, you'll be amazed how quickly
your home movies come together

with Windows Movie Maker 2.

Make Movies Liks a Pro

With transitions and effects like you
see in movies and on TV every day,
Windows Movie Maker 2 gives your
home movies an impressive
professional quality.

B,

Share Movies Snywhere Easily
Windows Movie Maker 2 makes it
easy to show off your movies. You
can send them in e-mail, post them
to Web sites, copy them to a CD, or
even copy to DVD!

See It m Action

hitp://www microsoft.com/windowsxp/moviemaker/default.asp

1Vl

Windows Movie Maker 2 makes home movies amazingly fun and easy, letting you create, edit,
and share your home movies right on your computer with a few simple drag-and-drop moves,
Add special effects, music, and narration. Then share your movie via the Web, e-mail, or CD.

s e
.Videos & Demos
~Top 10 List
Comparison Guide
~How to: Get Started
How to: Learn More

.How to: Be an Expert

DVGear
FREE digital video training
tape with every DVGear
workstation.

More special offers
See the complete list.

Mo,

Download Windows Movie
Maker 2

Make movies like the pros.
Add cool effects, transitions,
and more. Watch cool
sample movies made with
Windows Movie Maker 2.

Free Winter Fun Pack
Downloads

Get the Digital Video with
Windows Movie Maker 2
Winter Fun Pack and get cool
sounds, music, and titles and
transitions.
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Movie Maker VYideos

See videos of people like you doing
amazing stuff with Movie Maker—then
learn how to do it yourself,

Take It tothe NextLevel

Extend Your Experience with Plusl
Digital Media Edition

Plus! Digital Media Edition delivers
exciting new ways to enjoy your
photos, music, and home movies with
Windows XP.

Addd Fffects fo Titles

From freeze frame video to
claymation, Windows Mavie Maker 2
is loaded with tools and features that
give full reign to your creative
powers.

Creata Videg Transitions

Wipes, dissolves, and much more:
Check out all the great new
transitions that come with Windows
Movie Maker 2.

More Amazingl'hings

hitp//www microsoft.com/windowsxp/moviemaker/defaultasp

pMusic and Video, Instant
Communication, and Dicitsl Photoes

With the features in Windows XP you
can enjoy your favorite music and
movies whenever you like, exchange
instant messages with friends and
family, work with digital photos, and
more. Start here.

1/8/03 6:56 P,

Meptune Mediashare Video
Contest

Simply make a short movie
using Windows Movie Maker,
submit it to Neptune's Video
Gallery, and you could win.

Pixelan SpiceFX Packs

To enhance your editing
power and creativity, see
Pixelan's cutting-edge
organic effects and
transitions that you can add
to Windows Movie Maker 2.

Check Out Windows XP
Media Center Edition

Enjoy all the features of
Windows XP, plus watch and
record TV, manage music,
play DVDs, and more,

Windows Catalo
Find products built to work
with Windows XP.
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Windows Movie Maker > Get
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A feature of the Home and Professional
Editions of the Windows XP operating
system, Windows Movie Maker 2 for
Windows XP includes all of the tools and
features you'll need to create entertaining
movies that have a professional look and
feel. To use Movie Maker, you must have
Windows XP installed on your computer.
Please note that when you acquire Windows
XP, it comes with an older version of Movie
Maker—to take full advantage of all of the
power and fimetiomafity that Movie Maker
now offers, you may want to download
Movie Maker 2.

Windows Movie Maker 2 requires the
following minimum system configuration for
your PC:

» Microsoft Windows XP Home
Edition or Windows XP
Professional

= A 600 megahertz (MHz)
processor, such as an Intel
Pentium III, Advanced Micro
Devices (AMD) Athlon, or
equivalent processor

= 128 megabytes (MB) of RAM

Downlecad Windows
Movie Maker 2

Make movies like the
pros. Check out.-the
cool effects, transitions,
and more in Windows
Mowe Maker 2.

— .,

1‘%% L 4
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Plus! Digital Media
Edition

For exciting new
transitions and effects,
check out Microsoft
Plus!, which adds new
eye-popping visual
effects and transitions
from Pixelan Software.
If you enjoy these
amazing effects, you
can check out other
Pixelan products for
Windows Movie Maker
2

= 2 gigabytes (GB) of free hard disk space
= An audio capture device (to capture audio from external

sources)

http:#/www.microsofl com/windowsxp/moviemaker/getstarted/righthardware.asp

A DV or analog video capture device (to capture video from
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external sources)

= An Internet connection (to save and send a movie to the
Web or to send a movie as an attachment in an e-mail
message)

Keep in mind that video editing is a processor-intensive activity. In order to
optimize your experience and the performance of Windows Movie Maker,
we recommend the following:

= A 1.5 gigahertz (GHz) processor, such as an Intel Pentium
4, an AMD Athlon XP 1500+, or equivalent processor

= 256 megabytes (MB) of RAM

You will need capture hardware to transfer videos into your PC. The
hardware required will depend on the source of your video.

If'you have a digital video (DV) camera, you’ll need either a FireWire card
(also known as [EEE 1394) or an analog video capture card. FireWire is
recommended for the best quality results. Many new PCs come with a
FireWire card already installed. If not, there are a number of manufacturers
that make a card that will work with your PC.

If you have an analog camcorder, a Web camera, or a VCR, you will need an
analog video capture card. '

To p]éy the movies you’ve created with Movie Maker, you will need the
following software:

= Microsoft Windows Media Player 7.0 or later (Windows
Media Player 8 Series is recommended to optimize movie
playback)

= Microsoft Windows 98 or later or Windows NT® 4.0 or
later
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